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PREFACE

Every effort has been made to ensure that the information in this document is complete,
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of
errors beyond its control. The manufacturer also cannot guarantee that changes in software
and equipment made by other manufacturers and referred to in this guide will not affect
the applicability of the information in it. Mention of software products manufactured by
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
http:/ /www.okiprintingsolutions.com

Copyright © 2008 Oki Europe Ltd. All rights reserved.

Oki, Oki Printing Solutions and Microline are registered trademarks of Oki Electric Industry
Company, Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

EFI, Fiery, the Fiery logo, and Spot-On are registered trademarks of Electronics for
Imaging, Inc. in the U.S. Patent and Trademark Office.

Fiery Link, SendMe, and the EFI logo are trademarks of Electronics for Imaging, Inc.
Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.
Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may
result in equipment malfunction or damage.

A warning provides additional information which, if ignored, may
result in a risk of personal injury.

Specifications subject to change without notice. All trademarks acknowledged.
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ABOUT THIS GUIDE

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you to

become familiar with your product and to make the best use of its many powerful features.
The documentation is summarised below for reference and is found on the Manuals CD /

DVD unless indicated otherwise:

>

V VV V V V VYV

Installation Safety Booklet (printed)

Quick Configuration Guide

Quick User’s Guide

Advanced User’s Guide

Troubleshooting, Maintenance Guide

SendMe™ Guide (this document)

Fiery Manuals Suite

Installation Guides - for consumables and optional accessories (printed)

Online Help - accessible from control panels, printer drivers and utility software

PURPOSE OF THIS GUIDE

NOTE
This guide is applicable to the C9850MFP only.

The purpose of this guide is to provide you with information on how to use the SendMe
feature on your system efficiently and effectively.
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INTRODUCTION

EFI SendMe allows you to create digital versions of your paper documents and send them
electronically to a number of destinations. With EFI SendMe, you can send your documents
to:

> an e-mail address
> your printer

> a file storage device such as a file server, a document management repository, an
FTP site, or other storage device using NetConnect (an option)

EFI SendMe has editing and image correction tools, together with a number of sophisticated
document scanning features - all in a friendly graphical user interface.
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OVERVIEW

SendMe allows you to convert paper documents into digital files that you can send to a
specified destination. SendMe simplifies collaboration, distribution, and storage with an
easy-to-navigate touch screen.

The following table describes the workflow process for using SendMe.
STEP TASK FOE MORE INFORMATION
1 Launch SendMe from the Sendme tab “Accessing and exiting SendMe” on page 8

associated with the SCAN button on the
scanner unit control panel.

2 Log on to SendMe with your user name and “Accessing and exiting SendMe” on page 8
password. This ensures the security of your
network and e-mail server.

3 Select a destination for your document. “Selecting a send method” on page 10

4 Load your original document into the scanner | “Scanning a document” on page 11
unit. Check your file format and scanner
settings from the Scan tab and press Scan.

5 Preview the images of your document. “Viewing scanned files in SendMe” on page 14
6 To make adjustments, use the Edit tool “Editing” on page 16
options, available from the Edit tab.
7 Send your document. Press the Send tab, “Sending” on page 20
enter the destination information, and press
Send.
8 Log off and exit SendMe. Press the OFFLINE “Accessing and exiting SendMe” on page 8
button.
NOTE
If you do not have a SendMe user name and password, contact your SendMe
administrator.
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ACCESSING AND EXITING SENDME

LAUNCHING SENDME

1.

2,

Navigate to the SendMe tab associated with the SCAN button on the scanner unit
control panel.

Press the Launch SendMe button.

Send Me Mode

Currently - OFF LINE. Nof ready to go to Send Me.

SendMe
&éfi SendMe

Hold Queue

FTP Server SMB Mailbox Remi)t_eTooI
s A0 = 4 2] o) PARN Y iy Y-S

Send Me
Launch

Please Note: When launch efi SendMe - copy and
other functions will be disabled.

After use SendMe, press OFF LINE button to use
other function.

Active Jobs Job Log
R v B\ v

LOGGING ON

It is necessary for you to log on to EFI SendMe because you will be using secure network
resources such as your e-mail account or your document management system. When you
log on with your user name and password, SendMe provides you with access to these

resources.

1. Press the LOG ON button.

2. Type in your User Name using the soft keyboard and then press OK.

3. Touch the Password field and type in your password using the soft keyboard and

then press OK.

NOTE
If you receive an error when you log on, try again, double-checking the
spelling of your user name and password. Remember that your Login
information is case-sensitive. If you receive the same error the second time,
contact your system administrator for assistance.

4. If you are using NT authentication, enter your Domain name.

5. Press OK.
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LOGGING OFF

Before you leave the scanning station, be sure to log off. This protects your network
account access, and it enables others to log on with their own accounts. There is a Log Off
button on the Main tab as well as on the Send Confirmation page.

1. From the Main tab or Send Confirmation page, press LOG OFF.
2. At the prompt, press Yes to confirm that you want to end your SendMe session.

NOTE
As a security measure, you are automatically logged off when the EFI SendMe
station has been idle for 60 seconds.

3. Press EXIT SENDME to return to the main screen associated with the SCAN button
of the scanner unit control panel.

4. Press the OFFLINE button to enable the use of other functions.

NOTE
During On Line status, copying and other functions from the scanner unit
control panel are disabled.
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SELECTING A SEND METHOD

After you log on to SendMe with your user name and password, you can specify how you
want to send your document.

eﬁ_ ‘ S en d M e Welcome GLFreebush ‘

; i -
,,,,, e
_____ - Ed
E-MAIL NETCONNECT PRINT

LOG OFF I Start Over I

Status: no documents yet

Main f Scan J Edit J Send

From the Main tab, press the appropriate send method:

E-mail sends your scanned document to an e-mail destination. You can
choose to edit your scanned documents.

| NetConnect (an option) sends your scanned document to a destination, such
jl:l as your desktop, an e-mail address, file servers, or FTP server. In addition, you
= may include metadata information used for document indexing.

NETCONNECT

. Print prints your scanned document. You can choose to edit your scanned
Eu document.

PRINT

After you select a send method, you can adjust your scanner settings and file format
settings. See “Scanning” on page 11.
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SCANNING

Once you have chosen a send method, you will be taken to the Scan tab automatically.

SCANNING A DOCUMENT

Scan your documents to create digital versions of your paper copies.

1.

Place your document on the scanner glass or in the automatic document feeder
(ADF).

Check and, if necessary, adjust your scanner settings. See “Scanner settings” on
page 12.

Check and, if necessary, adjust your file format settings. Refer to “Appendix A - File
format settings” on page 26 and “Appendix B - Encryption” on page 30 for further
details.

Press the Scan button to start the scanner. The scanned images will display on
screen.

NOTE
You can add more pages to your current set of images by inserting more
documents into the scanner and pressing the Scan button again.

If you have another document to scan, press Start Over to erase your current
documents and settings and return to the Main tab.
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SCANNER SETTINGS

The scanner settings tell the scanner what type of document you have - for example,
double-sided, A4 - and what information you want to collect from the document - that is,
the colour information and image resolution. Select from the following setting choices:

INPUT SIZE

letter
Input Size

ORIENTATION

A

portrait

Orientation

The Input Size option indicates the size of the pages you are loading into
the scanner. Touch the Input Size icon to select an option. You can
choose from:

>Letter (8.5"x11")
>Legal (8.5"x14")

>Tabloid (11”x17")
>A4

>A3

>Auto

Page orientation indicates which side of the page is the top. You can
choose from:

>Portrait (short edge on top)
>Portrait (long edge on top)
>Landscape (long edge on top)
>Landscape (short edge on top)

If your document has a variety of page orientations, you can modify them individually with
the Clean Up tools on the Edit tab.

NOTE

Portrait and Landscape long edge on top orientations are available for legal,
tabloid and A3 sizes only.

COLOR MODE

Color Mode

EFI SendMe gives you the option to choose what colour information you
want to include with your digital image. You can choose from:

>Black & white
>Grayscale
>Color

NOTE

Colour information affects your file size. For example, black & white uses the
least colour information, so it creates the smallest file size.
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DPI (DOTS PER INCH)

The DPI (dots per inch) setting on your job will affect the resolution of
your document image. The more dots per inch, the higher the resolution
and the bigger the file size. Options available:

>150
>200
>300
>400
>600

B&W image: All dpi options available to choose from.
Grayscale image: Choose between 300, 400 & 600dpi.
Colour image: Choose between 300 & 400dpi.

DPI

NOTE

The more dots per inch, the higher the resolution and the bigger the file size.
We recommend that you use the lowest resolution without compromising the
clarity of the image.

INPUT
Choose the mode of input for your document. You can choose from:
>Simplex: You can scan only one side of the document.

simplex >Duplex: You can scan both sides of a document.
Input

FILE FORMAT
Save the document in the format you want. You can choose from:
‘@ >PDF (Portable Document Format)
ndf >JPEG/TIFF (Single/Multi Page Raster)
File Format >MS WORD/RTF

You can also set up image quality, OCR (Optical Character Reading),
language and encryption here.

Refer to “"Appendix A - File format settings” on page 26 for full details.

Scanning > 13



VIEWING SCANNED FILES IN SENDME

You can view full-page or multi-page thumbnails of your scanned files. Switch between
thumbnail and full page views by touching these icons:

Switch to the thumbnail view to view multiple images at once.

am
oo

The edit tools are available on the full page view.

Full Page

THUMBNAIL VIEW TOOLS

A thumbnail is an imaging industry term that means a very small representation of a page

- about the size of your thumb nail. This small view of your pages is useful for viewing many
pages at once.

Page Selection

: three choices:
1

1 >Select One Page

o

Select One >Select Multiple Pages
>Select All Pages

F=-—=—— Your page selection indicates which pages you want to modify. You have
1

1

1

Press Page Selection and touch the pages that you want to view or
modify. For example, if you select Select All and then select Delete
Page, all the pages in your selection are deleted.

Move Thumbnail Up

- Select one or more thumbnails and use the Up icon to shift them up. This
| . allows you to change the order of your documents with a single touch.

up

NOTE
This option is not available if select All Pages is selected for Page Selection.

Move Thumbnail Down

Select one or more thumbnails and use the Down icon to shift them

down. This allows you to change the order of your documents with a
v single touch.

d ot

NOTE
This option is not available if select All Pages is selected for Page Selection.

Thumbnail Size

D You can choose between three thumbnail sizes by touching the small,

medium and large thumbnail icons at the top of the screen to help you
get the right view of your images. If you have more than one screen full

Thurbrail Si of thumbnail images, you can drag your finger along the side scroll bar
—— on the right to scroll through the set of images.
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FULL PAGE VIEW TOOLS

You can review your document images one at a time using the full page view. These tools
are available at the top of the screen to help you view the image at different magnifications
and to navigate from page to page. These tools are also available on the full page view of
the Edit tab.

Zoom In

You can increase the size of the image on your screen by pressing the zoom in
% icon.

Zoom Out
q Likewise, you can make the image appear smaller by pressing the zoom out icon.

Move
i Move the image around your screen by pressing the move icon and then dragging
g "(._! your finger to the area of the image you want to view.
NOTE
This feature is only active if you have zoomed in on your scanned image.
First Page

Press the first page icon to view the first page.

=

Previous Page

T Press the previous page icon to view the previous page.
JI

Next Page

Press the next page icon to view the next page.

=

Last Page

]

Press the last page icon to view the last page.
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EDITING

SendMe provides a humber of editing and image correction tools that allow you to modify
the scanned document images before you send them. Using the tools on the Edit tab is
completely optional, but very helpful when you want your image to look a specific way.

There are several tools for your use.

1. Once you have scanned your documents, you may want to make edits. These tools
are available by touching the Edit tab.

2. Specify how you want to view your images. For more information about how to view
your scanned files see “Viewing scanned files in SendMe” on page 14.

3. Specify the edits you wish to make.

For information about SendMe editing tools, see “Image clean up - thumbnail view”
on page 16 and “Editing tools - full page view” on page 18.

4. Save your edits. After you make edits, you are asked to save your edits when you
press another tab, change to Thumbnail View, or move to another image.

IMAGE CLEAN UP - THUMBNAIL VIEW

On the Edit tab, there are several helpful image clean up tools to use while in the thumbnail
view.

ToP MENU TOOLS:
Insert Blank

You can insert a blank page as a separator page between your scanned
j images. Touch this icon to insert a blank page after your selected image.

Inserd Blank
Delete Page

5

Delete Pags

Touch this icon to delete the pages in your selection.

SIDE MENU TOOLS:
Border Removal
Touch this icon to remove any borders that appear on your selected document

—
| images.
You can change the default border width in Tool Settings. For more
information, see “Tool Settings” on page 17.

Deskew Page

To straighten an image, touch the Deskew Page icon and touch the image to
deskew.

‘_.-'I-

Lt
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Despeckle Page

o The Despeckle tool removes tiny dots (specks) that sometimes appear on
: scanned images.

You can change the default dot size in Tool Settings. For more information,
see “Tool Settings” on page 17.

I~ Change the orientation of an image by pressing the Turn Image icon and
- touching the image you want to rotate.

Turn Image
L You can change the default degree you want your image turned in Tool
Settings. For more information, see “Tool Settings” on page 17.

Tool Settings

>Border Removal: By default, this is set to Auto. SendMe can recognise
borders and remove them for you automatically. However, if you want to
specify a width, you can choose from Small (0.1 inch); Medium (0.25 inch)
or Large (0.5 inch).

% You can change the settings for border removal, despeckle and turn tools here.

>Despeckle: Choose from 3 speck sizes: Small; Medium (default) or
Large.

>Turn: Rotate your image 90° (default), 180° or 270°.

Tool settings

Border Removal
Small Medium Large Auto
0.1 inch 0.25 inch 0.5 inch O
Despeckle
Small O  Medium Large
Turn
o 90° 180° 270°

Undo

P

Undo

Made a mistake? Undo your last edit by touching the Undo icon.
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EDITING TOOLS - FULL PAGE VIEW

The editing tools are available only from the full page view on the Edit tab. You have the
same tools for navigating the full page images here on the Edit tab as you do on the Scan
tab.

Full Page view
To switch to the full page view, touch the Full Page icon in the top left corner.

You can view and select the editing tools by touching the grey Edit icon in the
top left corner of the screen.

Full Page

Select Area

~-==4  You can select and manipulate areas of the image. First, press on the Select
L I icon and then drag your finger along the diagonal of the rectangular selection.
1 1 Once you have a portion of the image selected, you can move that selection
to another area of the image by dragging the selection around the image with
Select your finger. You can also resize the selection.

Cut Selection

; If you want to move the selection to another section of the page - or to another
AL Page altogether, press the Cut icon, navigate to where you want to place the
’E} selection, press the Paste icon and touch the area where you would like the
selection pasted.
Cut

Copy Selection

Copying and pasting is just like cutting and pasting except that the original
L‘— selection stays in place.

Copy

Paste Selection

Press the Paste icon and then touch the location of the image where you want
?‘j the contents of your clipboard to be pasted.

Pazle

Pen Erase

Touch this icon to activate the Pen Erase tool. It will erase where you touch
{ the image. Eraser options are background colour (white or black) and line
O/ thickness.

Fen Eraze

Rectangle Erase

This tool erases everything that appears inside the rectangle you draw on
screen. Drag your finger from one corner of the rectangle diagonally to the
other side. You can specify a background color for the Rectangle Erase tool.

Fect. Eraze
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Undo

P
Undo
Redo

C

Redo

Made a mistake? Undo your last edit by touching the Undo icon.

You can press Undo 10 consecutive times to undo the last 10 edits.

If you accidentally touch Undo or you change your mind after Undo, use the
Redo icon to reverse it.

You can press Redo 10 consecutive times to redo the last 10 edits.
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SENDING

Now that you have finished editing your images, you are ready to take the final step of
sending your document.

1. Touch the Send tab.
You are always free to change the send method:
(a) Touch the Cancel button.
(b) Touch the Main tab.
(c) Select the new send method.
(d) Return to the Send tab to indicate the destination details.

If Encryption is specified for a scanned document, you will be asked to specify
encryption settings when you send the document. For more information see
“"Appendix B - Encryption” on page 30.

If you have Legal Stamping enabled for your scan station, you will be asked if you
want to use Legal Stamping for these particular documents. For more information see
“"Appendix C - Legal stamping” on page 31.

2. Enter the destination details.

Each send method has its own destination details you will need to complete. Refer to
the specific send method for instructions.

3. Touch the Send button.
You will receive confirmation that your document has been sent. You can then choose to:
> Send your current document to another destination

> Start again with a new document

NOTE

When you select start over, you are prompted to save your settings. If you
select No, you will lose any changes made to the current settings, and the
default settings are restored.

> Log off
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SENDING TO E-MAIL

.y

E-MAIL

When you send a document by e-mail, the only information you must enter is the
recipient's e-mail address. EFI SendMe will enter your information as the sender and add
default values for the file name, message subject and body. However, you can change
these defaults by touching the Change Details button.

1.

2.

If you would like to send an e-mail to yourself, just touch the Send to Me button.
Your e-mail address will automatically be inserted at the To area.

Enter the e-mail address of the recipient. Choose an e-mail address from:

> Your Local Address Book. This is a collection of the e-mail addresses you have
used in the past.

> The Global Address Book. The directory of e-mail addresses kept in the corporate
LDAP directory (if LDAP is enabled), or a list of all SendMe users.

NOTE
You can use filters to reduce the number of contacts in the list. The list of
contacts for that address book will appear in the Contacts area.

To select a recipient, touch the name in the list and then touch the To, Cc or Bcc
buttons.

Address Book

Local Global Direct
Address Address Email
Book Book Address

Quick Search

Contacts.
a,

Sheila Johnson <sj@web.com=

QLN Sheila Johnson

ﬁ_ Tommy Tumer <ttiweb.com=>

NOTE

If you are searching for a number in an address book, type the first few letters
of the first name in the Quick Search field. SendMe will show the address
book entries that match your search criteria.

If your recipient is not in an address book or directory, you can touch Direct E-mail
Address and type the e-mail address directly into the Direct Email Address field.

NOTE
There are “.com” and “.net” shortcut keys.
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Address Book

a.
Local Global Direct
Address Address Q | Email
Book Book Address

—
b Direct Email Addre c.
ﬁ rem-f_dlweb.:om

Recipients

LN Sheila Johnson

@jel emydwel.com

NOTE
To delete an entry in the recipient list, touch the recipient and then the Delete
button.

3. Press OK.

4. Your e-mail address is automatically put in the From address. If that is all you need,
touch Send to send your document via e-mail to the selected recipient.

5. If you wish to add more recipients, a subject, or message text, touch Change
Details to enter the rest of the e-mail message information.

6. Press Send when you are satisfied with this page.

If prompted, enter your user name and password.

NOTE

1. Your system administrator may have a limitation on your e-mail
attachment size. If so, and if your attachment exceeds the limit, you will
need to remove some pages from your document and resend it.

2. If Encryption is specified for your scanned document, you are asked to
specify encryption settings. For more information, see "Appendix B -
Encryption” on page 30.

3. Your e-mail address is automatically entered in the From address.

4. Your e-mail address is automatically added to the "Bcc” list if it is not
already in the list of recipients.

You will receive confirmation that your document has been sent. You can then choose to:
> Send your current document to another destination

> Start again with a new document

NOTE

When you select start over from the main screen, you are prompted to save
your settings. If you select No, you will lose any changes made to the current
settings, and the default settings are restored.

> Log off
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SENDING TO PRINT

PRINT
EFI SendMe will send your scanned document to print so you can have extra copies of your
document.

Before you start printing, go to the Scan tab and set the paper size, orientation and
simplex/duplex mode. Although the primary purpose of these settings is to control the
scanner, the paper size, orientation and simplex/duplex mode settings are also used by the
printer. It is therefore very important to double check your current scan settings before you
print.

1. Select print or hold queue from the Printer dropdown list.

r b

Printar — Please choose ane —
Flatame file - 0-19-07 - GLASDDD
Murriner of Coples

Pape Size — Defnlt --

Ed =

NOTE
The EFI default name for the MFP is 3640A3.

2. Enter the number of copies to print.

3. Specify the remaining print options (press the Next button to view the additional
pages) or leave the default settings.

4. Touch the Send button.
You will receive confirmation that your document has been sent. You can then choose to:
> Send your current document to another destination

> Start again with a new document

NOTE

When you select start over from the main screen, you are prompted to save
your settings. If you select No, you will lose any changes made to the current
settings, and the default settings are restored.

> Log off
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SENDING TO NETCONNECT

NETCONNECT

Using NetConnect, administrators can define preset file repositories with dynamic path
information, dynamic metadata and full Windows file security.

If you have the optional NetConnect feature installed, EFI SendMe can send your scanned
document to:

> an FTP site (a file server you can access using Internet protocols)
> any folder on your local area network

> an e-mail address
1

Select a workflow from the list of available options, and then press Next.

NOTE
Your SendMe administrator must enable NetConnect. For more information,
contact your SendMe administrator.

rF -
Please salect a dastination,
T+ Scanned Folder
Email with Metadata
{__,9 FTP Site
L. &

If the workflow saves the document to a folder, select from the list of available
subfolders, or create a new folder, and then press Next.

F =1
Pease slect a folder,

- \\home\uses\scan(iles

+ finance

+ markedng

I + sales

Foldar Mama | Meaw Folder
m m

2. If required, change the default document name and enter any document properties
required before you send the document to its destination.
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3. Press Send.

If Encryption is specified for your scanned document, you are asked to specify
Encryption settings. For more information, see “"Appendix B - Encryption” on page 30.

You will receive confirmation that your document has been sent. You can then choose to:
> Send your current document to another destination

> Start again with a new document

NOTE

When you select start over from the main screen, you are prompted to save
your settings. If you select No, you will lose any changes made to the current
settings, and the default settings are restored.

> Log off
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APPENDIX A - FILE FORMAT SETTINGS

When SendMe sends a document to a destination other than Print, it creates a physical
document file. Since the receiver is expected to open that file later, it is important that you
know about the file formats supported by the product.

SendMe supports the following popular file formats:

>

PDF (or Portable Document Format) is a popular file format that supports the
representation of very complex documents. It offers the following features:

> Any colour mode: B&W, grayscale and colour pages are supported as well.
> Multiple pages: More than one page can be stored in a single file.

> Compactness: This is the most compact file format available.
>

Hidden text: This is the only SendMe file format that is capable of recognising text
and thus making your pages searchable.

> Encryption: This is the only SendMe file format that can be sent with encryption
enabled.

PDF is the most recognisable name in the printing and publishing industry.

TIFF (or Tagged Image File Format) is one of the most popular raster image
formats, especially for black and white images.

> Any colour mode: B&W, grayscale and colour pages are supported as well.
> Multiple pages: More than one page can be stored in a single file.

> For B&W pages it is as compact as PDF, but for grayscale and colour images PDF
offers significantly smaller file size.

> No hidden text and no encryption are available.

TIFF is the second most recognisable file format in publishing after PDF. Still,
relatively few inexpensive viewers are able to open multipage or colour TIFF files.

JPEG is a well-known raster image file format for grayscale and colour images,
especially photographs.

> Only for grayscale and colour images; no B&W.

> Only a single page can be stored in a file.

> PDF offers a significantly better file size. TIFF and JPEG are the same.
> No hidden text and no encryption are available.

JPEG has a legendary reputation among photographers and all across the Internet.
Even free viewer and editor programs, including Web browsers, are able to open
these files.

Usually it is a good idea to set up the file format before you start scanning. There are
several tools for your use.
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PDF FILE FORMAT

1. From the Scan tab, press the File Format button to display the File Format Settings

window.
.-"?-—.
pdf
File Format
NOTE

For Print destination you cannot change the default file format. For this
destination the most appropriate file format is used automatically.

2. Press PDF.

File Format Settings

| File Format
PDF JPEGITIFF MS Word/ATF

Compression Sattings

Higden lext layer (QCR)

Document Language: English .

Comprassion Quality:

Law Medium
D High Maximum

Make secure via 128-bit encryption

3. Select Hidden Text Layer (OCR) to enable searching and indexing of your PDF
files after they are sent.

NOTE
If Advanced OCR is enabled, you may also select the document language to
improve OCR accuracy.

4. Specify the Compression Quality.

Black-and-white pages are always compressed with the Fax (CCITT Group 4)
Compression, which is very compact and guarantees intact image quality.

Color and grayscale pages are always compressed with a Smart Compression
technology, which is many times more compact than JPEG.

5. To enable SendMe encryption, select the Make secure via 128-bit encryption
option.

When you send the document, you are prompted to enter passwords and user
permissions. For more information, see “Appendix B - Encryption” on page 30.

6. Press OK to close the window.

Use the JPEG/TIFF raster format if you want raster image files.
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JPEG/TIFF FILE FORMAT

1. From the Scan tab, press the File Format button to display the File Format Settings

window.
lﬁj
r_aster
File Format
NOTE

For Print destination you cannot change the default file format. For this
destination the most appropriate file format is used automatically.

2. Press JPEG/TIFF.

File Format Settings

File Formai
PDF JPEGTIFF MS Word/RTF

Compression Setfings

B&W pages: Fax (CCITT Group 4} Comprassion
Color pages: JPEG Compression

JPEG Quality:

Low Medium
O  High Maximum

Image Format: O Indivichual Mulli-pasge
Pages TIFF

Coler File Type: JPEG O TIFF

3. Specify the JPEG Quality.

Black-and-white pages are always compressed with the Fax (CCITT Group 4)
Compression, which is very compact and guarantees intact image quality.

Color and grayscale pages are always compressed with JPEG Compression.
4. Specify Image Format.

You can send individual pages as separate JPEG or TIFF files. Multipage TIFF sends
the file as a single TIFF file.

5. Specify the Color File Type.

Choose JPEG or TIFF files for color and grayscale pages. Black-and-white pages are
always TIFF files.

6. Press OK to close the window.
Use the MS Word/RTF format if you want MS Word or RTF files.

NOTE
You must enable Advanced OCR to use this format.
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MS WoRD/RTF FILE FORMAT

NOTE
The Advanced OCR module must be enabled in order to select this format.
Contact your system administrator.

1. From the Scan tab, press the File Format button to display the File Format Settings

window.
word
File Format
NOTE

For Print destination you cannot change the default file format. For this
destination the most appropriate file format is used automatically.

2. Press MSWord/RTF.

File Format Settings

File Format
PDF JPEGITIFF MS Word/RTF

Comprassion Sattings

Format: O Word 97/2000/%P RTF
Options: \/ Retain Images

Document Language: |Em;||i5h j

Choose a file format: Word 97/2000/XP or RTF.
Indicate whether you want to retain images.

Choose the document language to improve OCR accuracy.

o n R

Press OK to close the window.
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APPENDIX B - ENCRYPTION

If your document is enabled with encryption, you must specify encryption settings when
you send your document. For more information about how to enable encryption, see
page 27.

Once you specify to send your document, the Encryption Settings dialog box displays.

Encryption Settings

Owner password:

Owner password again:
User password:
User password again

User Rights:

Enable printing
Enable content extraction

Enable editing

1. Specify the following password settings.

> Owner password: The password of the owner of the document. This is
mandatory information you must specify.

> User password: The password of the user of the document. Unlike the owner,
the user has certain restrictions regarding the document. This password is
optional. If you leave it empty, you can open the document without having to
type any password. If you specify a user password, you cannot open the
document without knowing the user password or the owner password.

2. Specify the following User Rights settings:
> Enable printing: Select if you want the user to have printing rights.

> Enable content extraction: Select if you want to allow the user to copy text
and images to the clipboard.

> Enable editing: Select if you want to allow the user to edit the document.
3. Press OK.
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APPENDIX C - LEGAL STAMPING

Your SendMe workstation might be enabled to allow Legal Stamping. SendMe supports
Bates Stamping and Client/Matter Stamping.

In the legal industry, a Bates number is a unique number assigned to each page of litigation
documentation e.g. “"Clarke vs Williams Exhibit A Page 1 of 30" to identify exhibits in a trial.
Before the trial, each party may use Bates stamping to identify all the pages in their
inventory of documentation for a case, e.g. *120001, 120002, 12003, etc.”

Bates numbering has uses outside litigation as well, whenever document images need to
be numbered.

Client/Matter Stamping does not use numbering, but allows you specify a stamp prefix,
such as your department name.

Your SendMe administrator enables legal stamping and maintains the following legal stamp
settings:

> Whether or not legal stamping is enabled

> Whether all users have the same counter or each user has an individual counter
> The placement of the stamp on the page

> Any text that precedes the stamp

> The number of digits in the stamp

If you require a change to any of these properties, contact your SendMe Administrator.
1. Press the Send tab.

If legal stamping is enabled, SendMe will ask you if you want to use legal stamping
for this group of scanned documents.

r -
Legal Stamping

0 Mo Stampang Cliend/Mattar Stamping Bates Stamping
Slar Mumier 1 Stamp Prefix:
Mumier of Digits: &

Fant Name: Azl Font Sizac 10
Prafarred Location on Papar

Top-Left O  TopMid Tap-Right m
Boaltarm-Len Battorm=Mid Botlom=-Right

LY 7

2. Select Client/Matter Stamping or Bates Stamping.
3. For Bates Stamping:
> Choose the start number.

> Specify a stamp prefix, which appears at the beginning of the stamp. For
example, your department name.

> Enter the number of digits. This provides preceding zeros to your stamp number.
For example, if you specify 5 as the number of digits, your first page would have
the number 00001.

> Select a font name to use for the stamp.

> Specify a font size for the stamp.
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> Select the location of the stamp to appear on your page.

NOTE

The preferred location on paper is used unless there is image data in that
location. In that case SendMe determines the appropriate location for the
stamp.

> Preview the stamp on the scanned documents (select the Scan tab to view).
> Press Cancel if you do not want to use the stamp.

For Client/Mailer Stamping:

Specify a stamp prefix. For example, your department name.

Select a font name to use for the stamp.

Specify a font size for the stamp.

Select the location of the stamp to appear on your page.

Preview the stamp on the scanned documents (select the Scan tab to view).

V VV V V V

Press Cancel if you do not want to use the stamp.

Press Next to continue sending your document with legal stamping.
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